INTRODUCTION TO
PROCESSING



What is Processing?
—

0 Processing is a programming language designed to
make programming easier

0 Developers were frustrated with how difficult it was
to write small programs for new programmers
Need for compilers
Software that wasn’t always free
Didn’t always work together

Took the joy out of process of learning programming



Goadl

0 Goal was to make a programming language that
would allow fast prototyping of ideas

0 Easy to use and teach at a middle-school and high-
school level

With minimal setup
Immediate visual feedback

Potential to undertake big projects using the language



Processing

0 Prototyping is done in the form of a sketch

0 Programmers keep adding a few lines and adding
to the sketch

0 Visual feedback feeds the curiosity that is inherent
in new programmers

0 The vision behind processing is to enable the process
of learning programming through creating
interactive graphics



Let us begin!
N

0 Easy to download and install processing from
http: //processing.org




Let us write our First Program

0 Think about graph paper

0 How would you draw a line between (O, O) and
(5,5)¢

0 Pick the x,y location of the starting point and the

X,y location of the destination point and connect the
dots in between

0 Please work with another student and draw a line
on the graph between

(2,0) and (2,6)
(2,4) and (6,4)



First Program
—

X, Y-coords X, Y-coords
of 1st point of 2" point

O Iine‘]O, 10, 90, 90;;

o This is your first program

o Type it in and click on the Triangle (Play button) in the

top menu or select Sketch—>Run

sketch_jul23a | Processing 1.2.1

Edit Sketch Tools Help

sketch_jul23a §

line (10, 10, 90, 90);



First Program
—

| —— sketch_jul23a | Processing 1.2.1
[File Edit Sketch Tools Help

sketch_jul23a §
line (10, 10, 90, 90);

What is different about the direction of the line?



Coordinates on the Screen
_

0 On a computer screen, the origin (0, 0) is always at

the top left location of the screen

(0. 0) (499, 0)

X values increase to the right

y values increase downwards

. L]
(0, 499) (499, 499)

Image credits: http://www.cs.sfu.ca/CourseCentral /166 /tid /translation_rotation.html
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Basic Shapes
—

0 Points, Rectangles, Triangles, Quadrilaterals etc.

sketch_140612a § _
point(10, 10);

D) O sketc.

point at >
(10,10)

rect(20, 20, 50, 50);

\_Y_}

X, Y-coords Length and
of 1st point Width of the
rectangle




Basic Shapes
—

0 Points, Rectangles, Triangles, Quadrilaterals etc.

X, Y-coords X, Y-coords X, Y-coords X, Y-coords
of 1st point of 2nd point of 3rd point of 4th point

O O O sketc... N ckerch 1§0612a §

A . |quad(38, 31, 86, 20, 69, 63, 30, 76);

triangle(13, 75, 28, 20, 26, 75);

X, Y-coords X, Y-c]ords X, Y-c]ords

of 1st point of 2" point of 3rd point



Draw basic shapes
—

0 Type out the code in Processing and Click on Run to
see d rectangle, a quadrilateral, and a triangle

0 O O sketc... |rlec-t(15, 15’ 20, 20);

?ﬁ:;7 quad(38, 31, 86, 20, 69, 63, 30, 76);

triangle(13, 75, 28, 20, 26, 75);




Ellipses and Circles

0 Ellipse can be represented by specifying the
The coordinates of the center of the ellipse
The radius of the ellipse in the X-direction

The radius of the ellipse in the Y-direction

0 ellipse(xc, yc, xrad, yrad);
<:> ellipse(30, 30, 35, 35);

C O Jellipse(50, 70, 40, 20);

0 A circle is an ellipse with the same value for the
x-radius and y-radius



Arcs

0 Partial ellipses/circles can be drawn by the arc function.
arc (x, y, width, height, startAngle, stopAngle);

0 The outer edge of the ellipse defined by x, y, width and height
(where x, y is the center if ellipseMode() is defined to be CENTER)

0 The angle is in radians or use radians(degrees) to convert degrees to

radians

0 Try the following:
arc (50, 50, 100, 100, O, radians(180));
arc (50, 50, 100, 100, radians(270), radians(360));
arc (50, 50, 100, 100, radians(270), radians(90));
arc (50, 50, 100, 100, radians(270), radians(450));
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Representing Colors
—

0 Colors in Processing are represented as a
combination of Red, Green and Blue values

0 O = no contribution of a particular color

0 255 = maximum contribution of a particular color
0 Pure Red = 255,0, 0

0 Pure Green = 0, 255, 0



Filling in shapes

0 Shapes can be filled in with different colors

// Set fill color to Red
fill(255, 0, 0);
rect(5, 5, 70, 30);

® O O sketc...

// Set fill color to Green
fill(e, 255, 0);
ellipse(20, 60, 25, 35);

// Set fill color to a shade of Green
fill(e, 127, 0);
triangle(50, 50, 70, 70, 90, 30);



Experiment with Color
—

0 Type out the following lines and see if you can
change the shapes and their fill colors

// Set fill color to Red
£i11 (255, 0, 0);
rect (5, 5, 70, 30);

// Set fill color to Green
£1i11 (0, 255, 0);

ellipse (20, 60, 25, 35);

// Set fill color to a shade of Green
£1i11 (0, 127, 0);

triangle (50, 50, 70, 70, 90, 30);

Red, Green, Blue combinations

Black =0,0,0

Yellow = 255, 255, 0
Orange = 255,102, 0
Brown = 165, 42, 42
Fuchsia = 255, 0, 255
Olive = 128,128, 0
White = 255, 255, 255

More combinations can be found using the Color Selector tool under the Tools menu




Opacity /Transparency

1

0 Opacity /Transparency fill(255, 0, 0); 1800 sketc... |
also defined separately rect(5, 5, 70, 30);

0 O = completely £i11(0, 255, 0);
transparent rect(25, 25, 40, 60);

0 255 = comple’rely Overlapping rectangles without transparency
opaque

fil11(255, 0, 0); 180 0 sketc..

rect(5, 5, 70, 30);
fill(e, 255, 04 127)f; ﬂ
0, 60);

rect(25, 25, 4

Overlapping rectangles with transparency



Using color & opacity
N

Resize the drawing canvas

size (200, 200);

fill(e, 200, 150);
ellipse(117, 130, 25, 40);

fill(200, 0, 100, 125);
rect(6, 68, 142, 50);
rect(33, 18, 80, 50);

fill(e, 200, 150);
ellipse(28, 130, 25, 40);



Stroke Weight

]
0 strokeWeight(value);

size (480, 120) QOOO

smooth () ;

ellipse (75, 60, 90, 90);
strokeWeight (8); // weight = 8 pix
ellipse (175, 60, 90, 90);

ellipse (279, 60, 90, 90);
strokeWeight (20); // weight = 20 pix
ellipse (389, 60, 90, 90);




Stroke Color
-

0 stroke (color) ;

0 Could be a single value (to specify gray scale)
o Could be 3 values for RGB

stroke (204, 102, 0):;
rect (30, 20, 55, 55):




Composition of Shapes
—

0 Drawing an alien — Lets call him Rooba
=ize (200,200} ;
background (255); // Specifies the background color

smooth(); // Specifies extra smwoothing of drawn primitives

ellipseMode (CENTER]) ;

sketch_jul23a @ﬂu rectMode (CENTER) ;

// Body

stroke (0} ;

£i11({150) ;

rect (100, 100,20, 100) ;

/7 Head
£i11(255);
ellipse (100,70, 60,60) ;

/7 Eyes
£il11(0);
ellipse(81,70,16,32);
ellip=se(119,70,16,32);

/i Legs

stroke (0);

line (90,150,80, 160} ;
line(110,150,120,160) ;




Activity — Modify Rooba

Modify the Rooba program to give the Alien a Square head.
Change its eyes and body to red. Then make it have three legsl!

size(200,200); // Set the size of the window
background(255); // White background
smooth();

// Set ellipses and rects to CENTER mode
ellipseMode(CENTER);

rectMode(CENTER);

// Draw Rooba’s body

stroke(0);

fill(150);

rect(100,100,20,100);
~ A
A
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// Draw Rooba’shead
fill(255);
ellipse(100,70,60,60);

// Draw Rooba’s eyes
fill(0);
ellipse(81,70,16,32);
ellipse(119,70,16,32);

// Draw Rooba’s legs
stroke(0);
line(20,150,80,160);
line(110,150,120,160);




Processing Sketch for Yin and Yang

0 Write a sketch to draw Yin and Yang,.
Make the sketch be 400 x400 and the Yin
and Yang be 200 x 200

0 Need to use ellipses and arcs

0 Write Yin and Yang on the screen using
text (“Yin Yang", 10, 30);

—~ 7\
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Variables

0 If you have a number stored on your computer and
would like to add 1 to it

An easy way to access to that location

Find the value of the number stored at that location

Increment the value

Store the new updated value back to that location

0 Definition: A variable is contains some known or
unknown quantity or information, a value.



Variable

0 Examples:
o char value = ‘a’;
ointi = 100;
o Float x = 0.33;

o String str1 = “USA”;



Variables Program — 3 circles
I T
size (480, 120);
smooth () ;
int y = 60;
int d = 80;
ellipse(75, y, 4, d);
ellipse (175, y, 4, d);
ellipse (275, y, 4, d);



Variables Program

]
stroke (255, 0, 0); // Set the Line Color to Red
strokeWeight (4); // Set Line Thickness to 4

£} Variables

int a = 50;
int b = 120;
int ¢ = 180;
int distance = 10;

b, at+c, b);

b+distance, a+c, b+distance);
b+2*distance, a+c, b+2*distance);
b+3*distance, a+c, b+3*distance);

line (&,
line (a,
line (a4,
(a,

line



Variables Program

T
[ o - - -~
B3 Java Examples A_@Iﬂu

0 Running built-in examples

(- |, Basics o
(- |, Topics

0 File->Examples->Books->Chapter || @ o

- | Books

. [ | Getting Started
04'> .| @ ), Chapter02
[} |, Chapter03
. [ . Chapter04
. -# Ex_04.01
@ Ex_04.02

0 Run Example 4-3 from the Getting | 3 o

. # Ex_04.05
started book

m




Variables Program

N
size (480, 120);
// Line from (0,0) to (480, 120)
line (0, 0, width, height);
// Line from (480, 0) to (0, 120)
line (width, 0, 0, height);
ellipse (width/2, height/2, 60, 60);



Refactor the Yin & Yang

0 Use variables to refactor your previous sketch such
that the Yin and Yang symbol is drawn relative to

one fixed point (such as the center of the Yin and
Yang)

0 Refactoring refers to restructuring a program
without changing its basic behavior.

A~
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Displaying text
—

0 To display text use the print line function (printin)

println (Y“Hello”);
-prints a line on the screen with the words Hel 1o in it

0 To print the value of a variable (e.g. celsius=32),
use

println (“"The temperature 1s ” + celsius);
—will print The temperature is 32 on the screen



Add an Image ]9;] ]Ia

0 Add Chinese characters for “yin yang” (look at
LoadPicture example) centered on top of yinyang.

0 Add your image to your sketch
menu Sketch->Add File

Pimage 1img;
img = loadImage(“yinyang.png”);

image(imgIXIY);

A~
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Conditional statements
e

0 Conditional statements allow conditional execution

int temperature = 90;
1f (temperature > 85)

{
println(“It 1s hot outside”);

J

else

{

println (It 1s pleasant outside”);



Conditional statements
e

0 What will be printed on the screen if temperature=702

int temperature = 70;
1f (temperature > 85)

{
println(“It 1s hot outside”);

J

else

{

println(YIt 1s pleasant outside);



Conditional statements

0 Can we add more conditions? Surel

int temperature = 70;
if (temperature > 85)
{
println ("It is hot outside");
}
else if (temperature < 50)
{
println ("It is cold outside");
}

else // Only when the variable temperature is >50 and <85
{

println ("It is pleasant outside");



Conditional Statement example

void setup () {
size (480, 120); B 0202

smooth () ; ‘//

void draw () {
if (mousePressed) { Example from “Getting Started with Processing Book”
£f111(¢(0, 0, 0);

}

else
f111 (255, 255, 255);

}

ellipse (mouseX, mouseY, 80, 80);



Loops
—

0 To print all the numbers from 1-10 on the screen,
you could have 10 consecutive print statements

0 What would you do to print 1-1000 numbers?

0 Use loops to iterate over a number and call o
specific command

for (int 1=0; 1 < 10; 1 = 1 + 1)
{

println (1) ;
}




Loops
—

Initialize variable 1 to O
Increment 1 by 1 until 1<10

For every distinct value of i execute the statements
within the curly braces

for (int 1=0,;1<10;1=1+1)
{

println (“The value of 1 1s 7 + 1);

J




Loops
T

0 Run Example 4-7 from the Getting started book

0 Run Example 4-8 from the Getting started book



Fahrenheit to Celsius conversion
—

println ("Temperature Conversion Program"):;
println("F 1A _I_ 1A C") ;

int celsius;

Temperature Conversion Program

for(int 1=0;1<130;1=1+10)
{
celsius = (1 - 32) * 5/9;

println(i + " " + celsius);




Nested Loops

T
0 Run Example 4-10 from the Getting started book

0 Compare Example 4-11 with 4-10
2 What is the difference?



Functions

0 Used to perform generalizable and repeatable
tasks

vold printTemp (1nt temp)
{

println ("The temperature is a balmy " + temp + " F");

4

printTemp (35)
printTemp (85)
printTemp (120

) ;

Output:

The temperature is a balmy 35 F
The temperature is a balmy 85 F
The temperature is a balmy 120 F




Functions
—

0 Invoking a function with a variable

int temperature = 35;
printTemp (temperature) ;
temperature = 85;

printTemp (temperature) ;

Output:

The temperature is a balmy 35 F
The temperature is a balmy 85 F




Functions
—

0 Major benefit of defining functions is the flexibility

0 Suppose you decide to display the temperature in
Celsius instead of Fahrenheit

0 Without functions, you would have to change every
line that displays the temperature in Fahernheit

void printTemp (int temp)

{
int celsius = (temp - 32) * 5/9;
println ("The temperature in celsius 1s " + celsius);

}




Functions
—

0 Now when you invoke

4

printTemp (35
printTemp (85
printTemp (12

’

S~—— N

)
)
0

0 The output is

The temperature 1n celsius 1s 1
The temperature in celsius 1s 29
The temperature 1n celsius 1s 48




Functions example - Calculator
—

0 Writing a program for a simple calculator (+-*/)

0 You need functions for addition, subtraction, division
and multiplication

0 You can then provide two numbers to the
appropriate function and it will compute and
display the result

add (int a, int Db)
{
int ¢ = a + b;
println (YThe result of addition 1s ™ + C);




Functions exercise - 2 minutes
—

0 Write a function that accepts two integers and
displays the value of their product

0 Use the add function below for reference

0 Discuss your solution with your neighbor

add (int a, int b)
{
int ¢ = a + b;
println (“"The result of addition is “ + cC);

~ A
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Built-in Functions - Processing
.,

0 line(x1, y1, x2, y2) = draws a line

0 printin(message) — prints a message to the screen

0 ellipse(centerX, centerY, xradius,yradius) - draws an
ellipse on the screen with specified parameters

0 stroke(255, 0, 0) // Set the Line Color to Red

0 and many more...



RESPONSE IN PROCESSING



Mouse responses

S
0 Mouse actions:

1 mouseX and mouseY are the coordinates for where the
mouse is.

0 pmouseX, pmouseY are the coordinates for where the
mouse was in the previous frame

0 mousePressed: boolean variable that is true if the
mouse is pressed, false otherwise

O mouseButton: LEFT, CENTER or RIGHT
0 Examples: 5-4, 5-5, 5-6, 5-7, 5-12

0 Examples: MouseDemo



Key responses
-

0 Key actions:

0 keyPressed: boolean variable that is true if a key is
pressed, false otherwise

0 key: the char value of key pressed

0 keyCoded: true if key is coded and not tied to a
specific key. For example: ALT, CONTROL, SHIFT, UP,
DOWN, LEFT, RIGHT

O mouseButton: LEFT, CENTER or RIGHT
0 Examples: 5-18, 5-19, 5-21



ANIMATION



Animation
]

0 Requires redrawing

0 setup() function is invoked only once — at the
beginning of the program

0 draw() function is invoked repeatedly — to
simulation animation



Animation

R
volid setup () {
size (640, 480);
smooth () ;
noStroke () ;

volid draw () {
fill (mouseX, mouseY, 0);
ellipse (mouseX, mouseY, 30, 30);



Animation — Speed and Direction
]

0 Run Example 7-3 from the Getting started book

0 Run Example 7-4 from the Getting started book

Please modify example 7-4 to make the pacman
bouncing back and forth between left and right walls

A~
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Animation of an Orbit
N

0 Examples->Basics->Math->PolarToCartesian



Animated Yin Yang

0 Version 1: Change the sketch size to be 800 x 400 and
animate the Yin Yang to move left to right until it touches the
right edge. Then it should reverse and move right to left until it
touches the left edge. Then it continues to move back and forth.

0 Version 2: Make the Yin Yang roll along its center! You
will need to use trigonometric functions sine and cosine to
calculate the coordinates of the center of the small circles.
The Processing functions are named sin() and cos() and
they take angles in radians. To use degrees, use the
radians() function. For example: sin(radians(180));

0 Version 3: Make it bounce! (more difficult)

—~ 7\
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A FOR ARRAYS!
A FOR AWESOME!



Store the price of an item
—

0 To store the price of an item you would use a
variable

0 To store the price of two items you would use two
variables

0 To store the price of three items you would use three
variables

0 To store the price of 17 items, ....



15% Discount on all items
—

0 Let us assume that you want to give a 15% discount
on every item in the store

o If A =100, after discount
A=A-(15/100*A) = 85

0 Find every variable (x) and perform
x = x —(15/100%x)

-y =y—(15/100%y)
z=2z-(15/100*z) and so on...



Find the average item price
7
0 Find every variable
0 Find their price
0 Compute the sum
0 Keep a track of the total number of variables/items

0 Compute the average = sum/num of vars

0 What if you forgot to include one variable??



Arrays to the rescue
N

0 int [] prices = {10, 20, 40, 60};

0 To sum all the prices, use a loop

int sum = 0;

for(int 1 = 0; 1i1i<prices.length; 1i1++) {
sum = sum + prices|[i];

}

println (sum) ;



15% discount
-

for(int 1 = 0; i<prices.length; i++) {

prices[i1i] = prices[i] -(15/100*prices[i]);



Average of prices
_—

0 Print the average of all the prices in the prices array

0 Refer to the sum code snippet

int [] prices = {10, 20, 40, 60};

int sum = 0;

for(int 1 = 0; 1i<prices.length; 1i++) {
sum = sum + prices[i];

}

avg = sum / prices.length;

// Compute the average

println(“"The avg 1s ” + avqg);



Min and Max

e
0 Calculate the min?

0 Calculate the max?

0 Calculate min and max?



Arrays Make Animations Awesome

I
0 Examples->Basics->Math->SineWave
0 An army of Pacmans?¢ Example 10-3

0 A Flotilla of YingYangs?
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